
How to Scaffold a Video 

Essay Assignment 
 

 

 

 

These are the steps with instructions incrementally introducing students to the skills that they 

need in order to create their own video essay. I recommend teaching at least the basic skills to 

adequately prepare students for a full video essay. The extra features can add provide students 

with more options but are not absolutely necessary. 

 

The instructions in this guide are mainly for iMovie but do include some PC-friendly 

instructions. iMovie is a simple and intuitive software and there are iMacs available in the library 

for students to use. 

 

Overview: 
Basic Skills (everything you need for a successful video essay) 
Step 1: Screenshot (capturing a still image) 

Step 2: Trimming a clip 

Step 3: Adding text to an image (Meme) 

Step 4: Screen capture (capture video without sound; GIF) 

Step 5: Voice-over Narration* 

Step 6: Editing two pieces of media together in one video with a transition* 

 

Extra Features (not necessary but increases the possibilities of what students can do) 
Step 7: Adding music* 

Step 8: Freeze Frame* 

Step 9: Zoom in or out* 

Step 10: Fast or slow motion* 

Step 11: Audio fade in and out* 

Step 12: Adding text to video* 

Step 13: Creating an Intertitle* 

 

* Instructions for iMovie only 

 
 

 

 

 

 



Step 1: Screenshot (capturing a still image) 
 

Mac: 

 

Shift + Command + 3 

 This will capture your entire display and will save it to your desktop. 

 

Shift + Command + 4 

This will give you a cursor that will allow you to select just a portion of your screen 

 

Command+Shift+5  

When you open Screenshot, a floating toolbar will appear at the bottom of your screen. You can 

select whether you want to capture a selection, a specific window, or the entire screen. 

You also have the option to record your screen (the entire thing or a selected portion) or set up a 

5- or 10-second timer delay. The default setting saves your screen grab to Desktop, but you can 

select other destinations under the Options menu. 

 

PC:  

 

Hit the PrtScn button/ or Print Scrn button, to take a screenshot of the entire screen 

This will save the image to the clipboard. You will then need to paste it into a document to view 

and edit. 

 

Or  

Alt + Print Screen or Fn + Alt = Print Screen to capture a screenshot of the active window. 

 

 

Or 

If you want to select a portion of your screen to grab, hit Windows+Shift+S. In Windows 10, this 

will open the Snipping Tool. Click Mode to select the type of screen grab you want to take. Then 

use your mouse to select the area of your screen or window you want to capture. 

 

 

Step 2: Trimming a clip 
 
For this assignment I provided students with a few 10 min. clips in a Google Drive folder that 

they could choose from to edit. They had to download their clip and then shorten it to their 

desired scene in their choice of software. 

 

Using VLC: 

Students probably won’t being using this method, but it is a neat trick that VLC does that you 

might find useful. 

 



This method will work on DVDs (if you are interested on doing that in the future) as well as mp4 

and m4v files.  

 

Download and install VLC https://www.videolan.org/vlc/index.html 

*VLC is a useful video player to have on your computer if you watch a lot of foreign films. It is 

region free, meaning you can play DVDs from any country. 

 

Open VLC, then open the clip you want to edit in VLC. 

 

Find the scene you want to record. (It’s best to have your time stamps already figured out.) 

 

Back the video up to before you want to start recording and hit play. 

 

In the menu choose “Playback” and then click “record” at the moment you want to start 

recording. (It’s usually a good idea to hit “record” a second or two early.) 

 

Let the video continue playing. Choose “Playback” and click “record” or “stop” again to stop the 

recording at the end of the clip. 

 

Your clip will automatically save to your “Movies” folder on your Mac and to your “Videos” 

folder on your PC. You can play open the clip in VLC to play it to check it. When you are 

satisfied rename the file so that you know what it is. and can find it later. 

 

 

Using iMovie: 

 

This method is for Macs only. This method involved more steps than VLC and is not as 

straightforward, but you will be using iMovie later to edit different clips together so you might 

want to start familiarizing yourself with the application now. 

 

Open iMovie and click on “Projects” at the very top. 

 

Clip “Create New” and choose “Movie” 

 

In the menu choose “File” and “Import Media” find the clip you are going to edit on your 

computer and click “Import Selected” 

 

Your file will now appear in the top left box on the program. Click and drag the video to the 

bottom half portion of the screen. You are now ready to start editing. 

 

Put your cursor on the beginning of the video, click, and drag the end to the scene where you 

want your clip to begin. Do the same for the end of the video. You are essentially shortening the 

video to only include the section you want. What is left in the middle is your clip.  

 

You can preview your clip in the top right box. 

 

https://www.videolan.org/vlc/index.html


Once you are satisfied with your clip. Click “< Projects” in the top left corner. You will be 

prompted to name your project. Type in a name and hit “Ok.” 

 

Once back on the projects page, click your clip so that the “…” appears. Click “…” choose 

“Share Project” and choose “file.”  Click “next” and then choose a location and name your file, 

then click “save.” 

 

It will take a little while to export the clip. Be patient and don’t try and open the clip until it is 

done. You will receive a notification when it is complete. 

 

 

Step 3: Adding text to an image (Meme) 

 
While a meme is not strictly speaking a skill necessary for a video essay, I always find it to be an 

incredibly fun assignment that produces really insightful content. In addition, students do learn 

some skills that they could apply to their video essays later. 

 

To make a Meme: 

 

Take a screen shot (see step 1). (Because I taught this assignment in a film class I had students 

make a meme from a still of the film we were watching, but you can easily have students make 

different kinds of memes by finding or creating their own images.) 

 

Any program that will allow you to overlay your images with text and/or set two images next to 

each other will work for finishing your meme, including PowerPoint or Preview. You can also 

use a website such as this https://imgflip.com/ if you prefer. 

 

For adding intertitles or text to video footage in iMovie see steps 12 and 13 of this document. 

 

 

Step 4: Screen capture (capture video without sound; GIF) 
 
A screen recording will record your computer screen. It can capture sound, depending on the 

method you use, but the sound quality is poor when recording a film because your computer will 

record it using its microphone not the audio from the video as VLC does. GIFs do not have 

sound, so it is not necessary to capture the video with sound for this assignment. This is also the 

easiest method for sourcing clips if you plan to add voice-over narration or music later. 

 

Mac:  
 

Step One: 

Have the film open and set up to start playing a few seconds before the segment you want to 

capture. 

https://imgflip.com/


 

 
 

 

Step Two: 

Open QuickTime. Tap “File” at the top of the display. Choose “New Screen recording” 

 

Or 

 

Command+Shift+5 or under Applications > Utilities. And chose “Record Selected Portion” 

 

 



 

 

Step Three: 

Select the area on your screen that you want to record and hit “record.” 

 

 
 

Step Four: 

Hit “play” on the video. And let the video play for the duration of the film you want to record. 

 

 
 

 



Step Five: 

Once you have captured the segment of the film that you want, pause the video and end the 

recording by clicking the “stop” button in the menu bar at the top of the screen. 

 

 
 

Your video will appear as a thumbnail in the bottom right-hand corner of your screen and be 

save to your desktop. 

 

 
 

 

 



1) You can click on it and immediately trim the ends down to 1-3 seconds.  

2) Or you can open the video in iMovie or your video editing software of choice and edit your 

clip down to 1–3 seconds in order to make your GIF. Option 1 will work but iMovie or another 

video editing software will be more precise. 

 

If you go with Option 1: 

Click on the thumbnail (shown in the picture above). You will only have a few seconds before it 

disappears so be quick. 

Click on the trimmer tool in the top right corner. 

 

 
 

Trim the video down to 1-3 seconds by clicking on the end and dragging them to your desired 

start and stop points. 

 



 
 

Once you have the section that you want, click “Done.” Your clip will be saved to your desktop. 

 

 
 

Once you have your 1–3 second silent clip use the following website to turn it into a GIF: 

https://giphy.com/ 

 

 
 

 

https://giphy.com/


How to Screen Record using PPT 

 

Step One: 

Have the film open and set up to start playing a few seconds before the segment you want to 

capture. 

 

 
 

Step Two: 

Open PowerPoint and go to the “Insert” tab. 

 

 
 

 

 

 

 



Step Three: 

Select “Screen Recording.” 

 

 
 

Step Four: 

Click “Select Area.”   

 

 
 



Step Five: 

Choose the specific area of your screen you want to record. Leave out all menu bars. You want a 

nice clean clip.  

 

 
 

 

Step Six: 

Click “Record.”  

 

 



Step Seven: 

The recorder will count down from 3. Then press “play” on the film.  

 

 
 

 

Step Eight: 

Let the film play for the duration of your desired clip. Once you have captured the segment of 

the film that you want, pause the film and end the recording by clicking the “stop” button in the 

menu bar at the top of the screen. 

 

 



  
You will be brought back into PPT and you will see your video in a slide. 

 

 
 

Step Nine: 

To save the recording, right-click on the video frame and select “Save Media as…”. Then follow 

the on-screen prompts to save your recording to your computer. 

 

 



Step Ten: 

Now open the video in iMovie or your video editing software of choice and edit your clip down 

to 1–3 seconds in order to make your GIF. 

 

Once you have your 1–3 second silent clip use the following website to turn it into a GIF: 

https://giphy.com/ 

 

 
Using Giphy 

 

Go to www.giphy.com 

 

Create an account. (It’s free) 

 

Click “Create”  

 

Click “Choose Video” 

 

Find the video you want to turn into a GIF on your computer and upload it to the website. 

 

If you haven’t already edited your video to 3 seconds or less, you can do so now. 

 

When you are done, click “Continue to Decorate.” 

 

Decorate your GIF as much or as little as you like. Keep in mind what you are trying to say with 

your GIF. What is the message? 

 

When you are done click “Continue to Upload.” 

 

Enter any tags you might want. When you are done, click “Upload to GIPHY.” 

 

 

Step 5: Voice-over Narration to both a still image and clip 
(including how to add a freeze frame in a clip)  

 

iMovie: 

 

Open iMovie and click on “Projects” at the very top. 

 

Clip “Create New” and choose “Movie.” 

 

In the menu choose “File” and “Import Media” find the clip/still you are going to work with on 

your computer and click “Import Selected.” 

 

https://giphy.com/
http://www.giphy.com/


Your file will now appear in the top left box on the program. Click and drag the clip/still to the 

bottom half portion of the screen. This is where you will build your video. 

 

 

Still Image: 

 

Because you have chosen to analyze a still you will want to lengthen the amount of time the 

image will appear for. iMovie will automatically set the image to run for 4 seconds. To lengthen 

that time, click on the end of the segment and drag it to the right until you reach the amount of 

time you need. You can always adjust this later. 

 

Adding Audio: 

You can either 1) record your audio ahead of time or 2) record it in iMovie. 

 

1) If you record it ahead of time using your phone or another program, you will need to import 

that file into iMovie as well and drag and drop it into the bottom part of the window (your 

workspace). 

 

The length of your audio will dictate how long your image needs to play for. Click and drag the 

end of your image to match the length of the audio. You can preview your clip in the top right 

box. Make adjustments as necessary. 

 

2) If you want to record your audio in iMovie, you will click on the microphone icon in the 

preview window (top right window in the program). 

 

Set your marker to the beginning of image and click “record.” There will a countdown from 3 

and then iMovie will start recording sound. Read your analysis and click the “record” button to 

end your recording when you are done. 

 

Adjust the length of the image to match the length of the audio. 

 

You can preview your clip in the top right box. Make adjustments as necessary. 

Clip: 

 

For a clip you are going to have to balance the length of the clip with the length of your audio. If 

your audio is longer than your clip you might have to create a freeze frame somewhere in the clip 

to pause the motion and take up more time while you speak. You clip should not be longer than 

your audio. You want to keep your viewer’s attention by directing them with your voice. Choose 

a clip that is short enough so that you do not have excess footage with no narration. 

 

I recommend recording the audio that you want first with a rough idea of the clip and then 

building the clip to match the audio.  

 

Or if you want to focus on a very short section of the film, which is always recommended (less is 

more), you can record your audio and then add freeze frames to lengthen the clip. 

 



See the tutorials on screen recording, building a clip in iMovie, and on adding a freeze frame for 

those techniques. 

 

Once you have a rough idea of your clip you need to add audio. 

 

Adding Audio: 

You can either 1) record your audio ahead of time or 2) record it in iMovie. 

 

1) If you record it ahead of time using your phone or another program, you will need to import 

that file into iMovie as well and drag and drop it into the bottom part of the window (your 

workspace). 

 

The length of your audio will dictate how long your clip needs to play for. Either edit your clip to 

match the length of your audio or add a freeze frame to lengthen the clip to the length of the 

audio.  

 

2) If you want to record your audio in iMovie, you will click on the microphone icon in the 

preview window (top right window in the program). 

 

Set your marker to the beginning of image and click “record.” There will a countdown from 3 

and then iMovie will start recording sound. Read your analysis and click the “record” button to 

end your recording when you are done. 

 

Either edit your clip to match the length of your audio or add a freeze frame to lengthen the clip 

to the length of the audio.  

 

You can preview your clip in the top right box. Make adjustments as necessary. 

 

 

Step 6: Editing two pieces of media together in one video 

with a transition 
 
iMovie: 

 

In the menu choose “File” and “Import Media” find the clips or still images you are going to edit 

on your computer and click “Import Selected.” 

 

Your file will now appear in the top left box on the program. Click and drag each piece of media 

to the bottom half portion of the screen in the order that you would like them to play. 

 

Edit each piece of media to your desire length. See step 2 for more on this. 

 

Once you have two pieces of visual media in your workspace one after the other you can insert a 

creative transition between the two if you like. 

 



Click on the “Transitions” tab at the top. 

 

Find the transition you want to use, click on it, and drag into the space between the segments.  

 

You can lengthen or shorten the transition by clicking and dragging the ends to make it longer or 

shorter. 

 

 

Step 7: Adding Music 
 

iMovie: 

 

This skill is similar to adding a prerecorded voice-over narration audio file. 

 

Import the music file into iMovie and drag and drop it into the bottom part of the window (your 

workspace). 

 

Position it where you would like it to play. 

 

You can edit the length of the music just as you do a video clip, by click on and dragging the 

ends.  

 

To have your music fade in or out see step 11. 

 

 

Step 8: Freeze Frame 
 

iMovie: 

 

You have already imported your media and dragged it into your workspace at the bottom portion 

of the screen. 

 

Find the scene that you want to make a freeze frame and click to place your marker there.  

 

Right click and chose “Add Freeze Frame.”  

 

You should now see a hand icon over the image you set as your freeze frame. You should also 

see a thin black line at the top of the image with a dark grey circle inside a lighter grey circle at 

the right end. You will click on this symbol and drag it to the right or the left to make the freeze 

frame longer or shorter. 

 



Step 9: Zoom in or out 
 

iMovie: 

 

You might want to zoom in to focus on a detail of a scene and/or back out again to get the full 

picture.  

 

You do this using the cropping tool at the top of the preview window in iMovie.  

 

Make sure you have the segment that you want to edit selected in the workspace before you 

begin (especially if you are working with multiple segments). 

 

Click the cropping tool at the top of the preview window. 

 

Select “Ken Burns.” This will do a gradual zoom. 

 

Use the box to select the area that you want to zoom in on or out from. 

 

To zoom in, hit the reverse icon so that the arrow is pointing toward the center of the box that 

you want to zoom into.  

 

To zoom out, the arrow should be pointing the other direction, toward the center of the full 

frame. 

 

Set your marker to the beginning of the segment and hit play to review. Make adjustments as 

necessary. 

 

Step 10: Fast or slow motion 
 

iMovie: 

 

You might want to speed up or slow down a clip to produce a certain effect.  

 

You have already imported your media and dragged it into your workspace at the bottom portion 

of the screen. 

 

Click the speed tool above the preview window. 

 

In the drop-down menu chose what it is you want to do. The options are “normal,” “slow,” 

“fast,” “freeze frame,” and “custom.” 

 

You can adjust just how fast or slow you want the clip to play by clicking on the percentages.  

 



Or you can click on the concentric grey circles on the clip itself at the end of the black line at the 

top of the clip in the workspace and dragging it left or right to make it slower or faster. 

 

Whether the clip is playing faster or slower than “normal” will be indicated by either a turtle or a 

rabbit icon on the segment respectively. 

 

Step 11: Audio fade in and out 
 

iMovie: 

 

You can make audio fade in or out. 

 

If you want to fade in, hover your cursor over the beginning of whichever audio segment you are 

working with. If you want to fade out, hover your cursor over the end of whichever audio 

segment you are working with.  

 

You should see a small concentric circle icon, similar to the one you seen when adjusting the 

time of a clip. 

 

Click and drag this icon either forward or backward to determine how long you want the fade in 

or out to take. 

 

 

 

Step 12: Adding text to video 

 
iMovie: 

 

You may wish to overlay either a still or a clip with some text. 

 

Click on the “Titles” tab at the top of the window. 

 

Choose the type of title you would like to add from the available options.  

 

Drag and drop the selected title in the appropriate location above another piece of existing visual 

media in your project.  

 

Click on the title in your workspace and then double click on the text in the preview window in 

the top-right corner in order to edit.  

 

You can type in your text, change the font, size, color, etc. 

 

You can lengthen or shorten the duration of the title by click and dragging on the ends. 



Step 13: Creating an Intertitle 

 
iMovie: 

 

Click on the “Titles” tab at the top of the window. 

 

Choose the type of title you would like to add from the available options.  

***Note if you scroll down, you will see a “scrolling credits” option if you want to insert credits. 

 

Drag and drop the selected title in the appropriate location, as a standalone piece of visual media 

in your project in the workspace in the bottom half of the window. (Do not place the title above 

another piece of existing visual media in your project. This will give you the effect of step 12.) 

 

Click on the title and then double click on the text in the preview window in the top-right corner 

to edit.  

 

You can type in your text, change the font, size, color, etc. 

 

You can lengthen or shorten the duration of the title by click and dragging on the ends. 

 


